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Introduction

 C3D - Cancer Central Clinical Database
 eCRFs Instructions Manual
 Support
 Data Entry
 Audit-Trail
 Discrepancy Management
 Verification
 Approval
 Lab Loading
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What is C3D 
 Clinical Trials Data Management System
 RDC (Remote Data Capture) Data Entry

 Accessible anywhere in the world (via a Windows computer and 
Internet Explorer).

 For studies prior with Clinical Center Number prior to 2012: The Java 
Runtime Environment (JRE) version 1.7.0_45 (or later) is required.

 The above requirement will no longer apply by mid-2017, when open 
studies setup in C3D before 2012 will be converted to a new interface –
‘RDC Onsite’.

 C3D supports data standardization, reuse, sharing, and 
interoperability through electronic Case Report Forms (eCRFs) 
based on Common Data Elements (CDEs)

 Based on Industry Standard Technologies
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C3D Organization

C3D Project

CBIIT CCR

Harris Protocol Builders Clinical TeamsApplication Support Standards

Help Desk

Maintain HW, SW, & DB

Build Protocols

Sponsor/Monitor Reporting



Designing Protocols in C3D

CR Doc

Forms & Rules
Testing

Protocol
Receiving

Clinical Analyst

Forms & Rules
Building

Initiation
Meeting

Control & Configurations Management Group (CCMG)

$$$

Requirement
Specification

Clinical
  Programmers

Clinical
Programmers

TeamTeamClinical Analyst

Activation
Meeting

Team

Protocol Protocol
Reqs

Protocol
Reqs

Sign-off

Protocol
Reqs

Sign-off
Build Doc

Protocol
Reqs

Sign-off
Build Doc
QC Doc

Protocol
Reqs

Sign-off
Build Doc
QC Doc

Protocol
Reqs

Sign-off
Build Doc
QC Doc

Rep Doc
Signoff

Team

Protocol
Reqs

Sign-off
Build Doc
QC Doc

Rep Doc
Signoff

Change
Request

Report
Building

Signoff



8

CCR Standard Case Report Forms

 Library of Standard Forms & Rules is available as a starting 
point to build protocol specific forms & rules

 Detailed Instructions are available for each Standard Form
https://ccrod.cancer.gov/confluence/x/9QiJAw

 Each Instructions includes:
 General Description
 eCRF Screenshot
 Field Specific Description (Mandatory, Derived, etc.)
 Validation/Derivation Rules

https://ccrod.cancer.gov/confluence/x/9QiJAw
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eCRF Instructions Manual



CCR Standard Case Report Forms

 Screening/Baseline Forms
 Eligibility, Enrollment, PE, Vitals, Baseline Symptoms, 

Prior Therapies, …
 Courses/Cycles
 Course Initiation, Study Medication Administration, PK, 

Course Assessment, PE, …
 Labs
 Blood Chemistry, Hematology, …

 Ongoing
 AE, Concomitant Measures, Extent of Disease, …

 Off Tx / Follow-Up / Off Study
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C3D Protocol Phases



Role Based Access
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Access =>

Role

Browse Enter Data Manage
Discrepancy

Verify
eCRF

Approve
eCRF

PI Yes No No No No

Research 
Nurse Yes Yes Yes Yes No

Data 
Manager Yes Yes Yes No No

Monitor Yes No Yes No Yes

QA Yes No No No No

Protocol 
Builders Yes Yes Yes No No



NCI/CCR Confidentiality Agreement –
Training Certificate
 At the end of the Training session, print, sign and fax 

the CCR Confidentiality Agreement to 240-541-4435. 
You can also scan and e-mail it back to the Trainer.

 Upon receipt of the CCR Confidentiality Agreement:
 The request for your C3D account, password and access 

will be submitted. The C3D Help Desk will provision your 
C3D account within 2 business days.

 The Certificate you attended the training will e-mailed to 
you.

 Keep your signed CCR Confidentiality Agreement and the 
Training Certificate in your Study’s regulatory binder.
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C3D Support
 CBIIT provides the first line of support for C3D related 

issues
 Contact

 Email: ncicbiit@mail.nih.gov
 Phone: 240-276-5541 (Toll free: 888-478-4423)

o Telephone support is available Monday to Friday, 9:00 a.m. to 5:00 p.m. 
Eastern Time, excluding government holidays.

 Additional Information at: 
https://ccrod.cancer.gov/confluence/x/KwBYB

 Protocol specific issues are escalated to the Protocol 
Builder by CBIIT

 Changes to Standards are escalated to Controls & 
Configuration Management Group (CCMG)

mailto:ncicbiit@mail.nih.gov
https://ccrod.cancer.gov/confluence/x/KwBYB
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Username & Password
 Username is typically your last name and first name initial.

Ex: smiths
 Password rules:

 Start with a letter;
 Must containing at least one number and one special characters (Ex:! #);
 Has to be at least 8 characters long;
 The following special character could cause problems if used: $ % & ‘ ‘’ /.

 Production Database is called ocprod
 About C3D Password:

 Do not share the password with others!
 Password needs to be changed the first time you login.
 Passwords expire every 4 months and need to be changed.
 Account gets locked upon three unsuccessful attempts. Contact C3D Help 

Desk to unlock account and/or get new password.
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C3D Login Web Pages

 C3D is Accessible Worldwide

 C3D Production Login Page:
https://octrials.nci.nih.gov/opa46/rdclaunch.htm

 C3D provides a separate Data Entry 
environment to test protocol design
 Test Login page:

https://octrials.nci.nih.gov/opa46/rdclauncht.htm

https://octrials.nci.nih.gov/opa46/rdclaunch.htm
https://octrials.nci.nih.gov/opa46/rdclauncht.htm
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C3D Login Web Page

Click on Login Button

For studies with NCI Clinical Center Number prior to 2012 
(ex: 11_C_0001, 10_C_0002), click on the Login button.
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Login

Enter User, Password, and Database. 
Then click Connect
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C3D Activity List

Select All Data, Active 
Discrepancies, etc.

Choose Different Studies

Specify Search Criteria

Select Data for specific 
Site or Patient

Study Summary



20

Selecting Activity
 Quick Links to View

 All Study Data
 Discrepant Data
 Site Specific or Patient Specific Data

 Change Study button to choose a Different Study
 Default Study is preserved from prior login
 Access to study sites and C3D features are controlled by user role

 Search button used to locate eCRFs based on one or more 
criterion

 Quick Tip:
 This screen provides a quick review of open discrepancies in your 

study
 It is strongly recommended to work with one patient at a time 

when performing data entry to avoid entering data in the wrong 
patient position.
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Selecting Study

Select Study & Click OK



Study Access

 Study/Site access and C3D features 
determined by user role

 User Roles:
 Data Managers (Performs Data Entry)
 Research Nurse (Performs Data Entry and Verifies 

eCRFs)
 Monitor (Read-only access and Approves eCRFs)
 Principal Investigator (Read-only access)
 Reviewer (Read-only access)
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Search Criteria

Search Criteria Dialog Box
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Search Criteria
 Search options:

 Book - collection of CRFs for a particular version of the protocol (initial 
version or amendments)

 Site
 Patients

o Range of Patients
 Visits/Pages

o Phases, Visits, etc.
 CRF Status

o Complete, Discrepant, Verified, Approved, etc.
 CRF Entry Date Window

o Entry or Modification Date Ranges
 Data

o Data entered in an eCRF

 Quick Tip:
 Protocol Amendments may require different DCI Book. Latest DCI book is 

the default one. Use Search option to select a previous book.
 Search Criteria Could be saved for future use.
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RDC Spreadsheet

Patients down the left

An Icon indicates the eCRF 
has been created for the 

corresponding patient

Phases or Visit tabs 
across the top

Display summary information 
about a Visit, a Patient, a Planned 
eCRF or the selected eCRF. 

Pull Down to view eCRFs 
by Phases or Visits Pull Down to view additional Visits

Active Filter

Each column represents 
a planned eCRF
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Navigating RDC Spreadsheet 
 Spreadsheet Layout 

 Patients along Rows
 Phases or Visits Tabs along Columns; pull down for additional 

visits
 eCRF within Tabs
 Cells represents an eCRF for the corresponding Patient-Visit

 Tabs can be organized by Study, Phase, & Visit
 When working with Lab eCRFs, choose to work with Visits instead of Phases or 

Study.
 Information Tabs for Summary, Discrepancies, Verification, 

Audit-trail, etc. at the bottom
 Navigation Functions via

 Menu
 Toolbar
 Hot Keys
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eCRF Icons
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Important eCRF Icons

 Square icon represents manual entry
 Round icon represents automated entry (lab load)
 An eCRF just created, but without data has no lines 

within the icon
 Partially entered eCRF has lines across half of the 

icon
 Completed eCRF have lines across the whole icon
 Blank Square icon indicates eCRF has been marked 

blank
 Red icon indicates one or more open discrepancies
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Electronic CRF (eCRF)

Tabs for eCRF 
Sections Non-enterable field

Yellow – Univariate 
Discrepancy

eCRF Scroll Bar

Ellipsis indicates 
field has a Pick List 
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eCRF Navigation

 Clicking on eCRF icon open the eCRF
 eCRF may contain tabs for the different 

sections of the eCRF
 Grey Fields indicates non-enterable fields 

(Derived, Defaulted, etc.)
 eCRF Scroll Bars indicate additional information
 Ellipsis indicates the field has a Pick List. Click 

on the ellipsis or press F9 to display the Pick 
List.
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Audit Trail

eCRF specific Audit Trail
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Audit Trail

 Audit Trail Tab shows history of all changes 
made to a specific eCRFs

 Shows current and prior values for each 
changed eCRF field along with the date of 
change and the user who made the change

 Quick Tips:
 Auditing Begins after Form is marked complete
 Do not share user ids and passwords!
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Resizing eCRF Window

Click Title Bar to enter 
Resize Mode

Then Click and Drag 
the Title Bar to move 

the window or the 
sides/corners to resize

Click Done when 
resizing is complete
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Resizing eCRF Window

 Click on the eCRF title bar to enter resize 
mode

 Click and drag title bar to move window
 Click and drag window edge to expand/ 

reduce window size
 Click OK when Done

 Quick Tip:  
 Right mouse click on the eCRF title bar to show a pop-up menu 

with options to move/resize the eCRF window.
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Log Out

Log out using Exit



Log Out

 Exit C3D before closing the Browser
 Inactivity for more than 30 minutes logs your 

out automatically. Any unsaved work is 
lost!
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Inserting New Patient

Icon to Insert New Patients

Choose Patient Position
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Inserting New Patient

 Click Patient Icon or Select Insert -> Patient from the 
menu bar

 Choose a Patient Position Number from the pick list
 New Patient Row is Created

 Quick Tips:
 The total number of Patients available for entry are 

governed by protocol ceiling accrual.  Request additional 
patient numbers if protocol is amended.

 It is a good practice to use the patient numbers in sync with 
those assigned by Central Registration Office (CRO)
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Starting New Planned eCRF

Click on empty Cell to 
insert eCRF and begin 

data entry



Starting New Planned eCRF

 Click on an empty cell to insert eCRF and 
begin data entry

 Resize if necessary  
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Entering Visit Date

Enter Visit Date and press Tab key
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Entering New eCRF
 Click on the empty Cell to insert appropriate eCRF
 Enter the Visit Date
 Visit Date is the Lab Sample Collection Date for Lab 

eCRFs!
 Visit Date is mandatory except for Ongoing Visit eCRFs.
 Partial dates are not acceptable.
 Consult eCRFs Instructions Manual for eCRF specific 

guidance:
o Usually Evaluation Date, Administration Date, Initiation Date, Lab 

Date, Course Start Date, etc.
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Entering Data in eCRF

Tabs for eCRF sections

Indicates Pick List

Non-enterable field

Use Tab to move between fields

Yellow – Univariate 
Discrepancy

eCRF Scroll Bar
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Entering Data in eCRF
 Navigating between Fields

 Use Tab Key to move to Next Field 
 Use Shift Tab to move to Previous Field
 Use Mouse Click to navigate to a Specific Field

 Fields with Ellipsis indicate a Pick List (Use the Pick 
List!)

 Enter Dates as
 Complete dates for Current Information (ex: 5/23/2014, 5-

23-2014 or 05232014)
 MMYYYY for Prior Information is acceptable when 

complete date cannot be obtained (ex: 05-00-2014, 
05/00/2014, 05002014 )
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Tabular eCRF
To Delete Selected Row

Number of Rows (Repeats) 
allowed for entry and displayed 

are set by Designers. 
Table does not have scroll bar. 
Use Up/Down Arrow Keys to 

Navigate beyond the visible rows.
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Tabular eCRF

 Fields shown in a grid layout
 Scroll up and down the rows of the table using arrow 

keys (No Scroll Bars!!)

 Quick Tips:
 Use the menu option CRF -> Insert Row to insert a row 

between two rows (below the currently selected row). 
 A row cannot be left blank and must be deleted before 

proceeding to another row. 
o Select the menu option CRF -> Delete Row.
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Using Pick List

Click on Field Ellipsis or 
Hit F9 to show Pick List



48

Using Pick List
 Fields with Ellipsis contain a Pick List
 Pick List can be accessed by clicking the Ellipsis or pressing the F9 

Key
 Searching the Pick List:

 Start typing in some letter and the list is filtered as you type or;
 Click on the Find box, enter a some letters surrounded by the wildcard % 

character (ex:  %ypo% ) and click on the Find button. Select one of the values.
 If the Pick List has more than 1,000 items, items beyond 1,000 cannot be 

searched after the Pick List is shown. Close the Pick List and use the 
wildcard find shown above then press the F9 key or click on the ellipsis. This 
way the entire list will be searched and matched items shown. The following Pick 
Lists have more than 1,000 items:
o CTCAE Term (version 3.0) pick list on the Adverse Events and Baseline Symptoms;
o Agents in the Concomitant Measures and Medications;
o Enrollment eCRF Disease Term (only when using comprehensive CTEP list of 

Diseases);
o Enrollment eCRF Registering Institute;
o Course Initiation eCRF Treating Institute.

 Quick Tips:
 If a value is not in the pick list enter it, consult your DM Supervisor. Entering 

a value that is not on the pick list will create a discrepancy.
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Marking eCRF Blank

Marking Section Blanks

Marking entire eCRF Blank
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Marking eCRF Blank
 Entire eCRF can be marked Blank
 Individual Sections of an eCRF can be marked Blank
 Checking Blank Flag will erase any entered information 

from the eCRF/Section
 Blank Flag can be unchecked to enter information

 Quick Tip:
 It is a good practice to mark Sections that will not have data 

entered as Blank.
 Once all sections of a CRF are ‘addressed’ (by entering data or 

marking it as blank) the overall status of the eCRF becomes 
Entry Complete.



Entering/Viewing Laboratory Data
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Add Unplanned

Show/Hide 
Unplanned



Entering/Viewing Laboratory Data

 Laboratory Data eCRFs are designed with 
dedicated Tabs (Hematology, Blood Chemistry, 
Urinalysis, etc.)

 Additional Lab eCRFs can be viewed by 
clicking Show Unplanned Events

 Additional Lab eCRFs can be added by:
 Select the appropriate Lab Visit;
 Open the patient’s last Lab eCRF on the selected visit;
 Then select the menu option Insert -> Visit

o Do not select Insert -> CRF
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Saving eCRF

Save Icon
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Saving eCRF

 eCRF can be saved using 
 Toolbar Save Icon (yellow floppy disk)
 F10 Key
 File -> Save menu option

 Quick Tip:
 Save Often!! Especially while entering Ongoing 

Information such as AEs and ConMeds.
 C3D session terminates without warning if there is 

no activity for 30 minutes.
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Data Entry Change Reason

Data Changed
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Data Entry Change Reason

 Change Reason needs to be specified while 
changing data on completed eCRF

 Change Reason becomes part of the Audit Trail 
along with date of change and user name

 Comments can be provided in the change reason to 
further explain

 Quick Tip:
 Do not use personnel/patient names or identifiers in the 

comments.
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What is a Discrepancy?
 A discrepancy is the failure of entered data to pass a 

validation check as applied by C3D.
 C3D validation checks are defined based on the definition of 

the fields, logical rules, protocol specifications, and sponsor 
requirements.

 Discrepancies are tools to assist teams in identifying 
potential data inconsistencies and facilitate real-time QA of 
data.

 Quick Tips:
 Discrepancies do not cover 100% of possible data 

inconsistencies.
 Clinical judgment may supersede discrepancy logic.
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C3D Discrepancy Types

 Univariate
 Generated during data entry/load when data is in some way 

different from the Question’s definition (e.g. mandatory, length, 
type, range, pick list, etc.)

 Multivariate
 Based on a condition on one or more questions as defined in a 

validation rule
 Generated on-line or when validation rules are run (eCRF must 

be saved as Complete.)

 Manual
 Generated by data entry operator seeking clarification on data 

values
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Some Typical Discrepancies
Types Example: Resolutions

Data Type Text entered in numeric or date 
field.

Review Source Document and 
enter appropriate data.

Length 
Problems

Too many characters entered. Use NIH accepted 
Abbreviations.

Value not on 
the Pick List

Generic Agent not present in 
Concomitant Agent Pick List 
and user typed in an Agent not 
found on the Pick List.

Search for alternates.
Consult Team Lead.
Request value to be added to 
Pick List.

Mandatory 
Value

Required Field left empty. Refer to Source Document.
Design modification.

Partial/Invalid 
Dates

00-10-2010 entered, but field 
requires a full data such as 01-
01-2010

Refer to Source Documents.
Check Day Month Year order.
Check that date is not in the 
future.
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Outstanding Discrepancies in a Study
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 Total number of Discrepancies in a study are 
shown in the Activity List

 Clicking on the ‘Review xx Active 
Discrepancies’ link will present only the 
Discrepant eCRFs

 Quick Tip:
 Data Managers should manage their 

discrepancies every morning to help ongoing QA 
of data.

Outstanding Discrepancies in a Study
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eCRFs Containing Discrepancies

eCRF Containing 
Unreviewed Discrepancies 

are displayed as Red



eCRF Containing Discrepancies

 eCRF containing discrepancies are shown in 
Red

 It is a good practice to address discrepant 
eCRF on an ongoing basis
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Discrepancies Tab

Discrepancies in the selected eCRF 
are summarized in Discrepancies Tab

First tab enumerates all discrepancies. 
Additional tabs provide individual 

discrepancies details.
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Discrepancies Tab

 While viewing an eCRF, clicking on the 
Discrepancies Tab shows the discrepancies 
on that eCRF

 The first tab gives the summary of all 
discrepancies in that eCRF (open and 
closed)

 Additional tabs provide individual 
discrepancies details.



66

Discrepancy Details

Each Discrepancy Detail is in following tabs

Disc History is available via this button
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Discrepancy Details

 Subsequent tabs show details for each 
discrepancy

 Open Discrepancies are displayed first and 
are followed by Closed Discrepancies

 Quick Tip:
 Double Clicking on the Discrepancy Text brings up 

a pop-up box with the entire message
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How are Univariate Disc. Created?

Univariate Disc Pop-up

Description

Operator can cancel to not 
create the discrepancy

Alternatively, operator can 
accept to create univariate disc
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How are Univariate Disc. Created?

 Univariate Discrepancies pop-up is presented during data entry 
when the entered value does not match the field definition.
 Mandatory field left empty
 Text entered in a Date or Numeric Field
 Too many characters entered
 Value is not on the Pick List
 Partial Date entered when a complete date is required

 Data Entry operator can:
 Cancel the pop-up and fix the value
 Or accept the discrepancy

 Quick Tip:
 Univariate Discrepancies are reassessed during Batch Validation for Design 

Changes.
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How is a Univariate Disc. Displayed?

Data Values with Univariate 
Discrepancies is highlighted

Data Values with Univariate 
Discrepancies is highlighted
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How is a Univariate Disc. Displayed?

 Discrepant data is highlighted in Yellow
 Discrepancy text provides the details

 Quick Tip:
 Double Click on the Discrepancy Message Text to 

view the entire message in a window.



How are Multivariate Disc. Created?

 Multivariate Discrepancies are created based on validation rules 
programmed in a study
 Example 1: Create Discrepancy if the entered BSA is not within 10% of the 

calculated BSA
 Example 2: Create Discrepancy if Date of Histological Confirmation is 

before Date of Diagnosis

 Quick Tip:
 Rules available as a standard on each eCRF are summarized in the eCRFs 

Instructions Manual.
 Though several standard rules are implemented for each eCRF as specified 

on the eCRFs Instructions Manual, clinical teams can request them to be 
turned off or modified to comply with the Protocol. 
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Evaluation of Multivariate Rules
 Validation Rules are evaluated:

 on-line validation rules are evaluated upon completion of a CRF 
Saved as Complete

 during an overnight batch validation session for CRFs Saved as 
Complete

 Multivariate Discrepancies are displayed in the same 
manner as Univariate Discrepancies. The Discrepancy 
Details panel indicates the type of Discrepancy.

 Quick Tip:
 Complex rules run overnight.
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How is a Multivariate Disc. displayed?

Discrepancy 
Description

Discrepancy tab

Related Data
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How is a Multivariate Disc. displayed?

 Discrepancy is based on one or more fields and is 
NOT highlighted in Yellow

 Discrepancy tab provides the details
 Discrepancy Text
 Involved Clinical Data in the evaluation of the Discrepancy

 Quick Tip:
 The Action pull-down “Go to Data Field” does not work as 

the discrepancy could be based on more than one field.



How to Address a Discrepancy
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Choose Go to Data Field from Pull Down Menu

Fix Data as indicated in the Discrepancy Text
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How to Address a Discrepancy

 Review Discrepancy Details
 Whenever possible, use the Action pull down ‘Go to Data 

Field’ to jump to the Discrepant Field
 Resolve the discrepancy by:

 Consulting Source Documentation and;
 Modifying incorrect data and specifying change reason;
 Requesting eCRF Design and/or Validation Rule Change.

 Quick Tip:
 System obsoletes univariate discrepancy automatically when 

data is corrected and complies with design/rules.
 Multivariate Discrepancies are only re-evaluated during overnight 

Batch Validation.
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Verification & Approval
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Verification & Approval

 C3D Verification & Approval functionality 
offer capability to track QA and Monitoring of 
eCRFs.

 Verification functionality is available for users 
with Research Nurse account role.

 Approval functionality is available for users 
with Monitor account role.
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Verification

Verify Button

Verification Tab
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Verification

 Each eCRF can be verified by clicking on the 
Verify button

 Verified eCRF Icon has a Checkmark 
 Editing a verified eCRF changes its icon to a 

Re-Verify status 
 Edited eCRF can be re-verified
 eCRF Verification Change History is 

maintained in the Verification pop-up 
Window
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Verification

Verified eCRF

Re-verification
Required
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Verification

Re-verify Button
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Approval

Approval Password

Approved

Verified & Approved

Re-Approval required

Approval Tab
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Approval

 Each eCRF can be approved clicking on the 
Approve button and providing your C3D 
password

 Approved eCRF Icon has a Signature
 Editing an approved eCRF changes its icon 

to a Re-Approve status
 Edited eCRF can be re-approved
 eCRF Approval Change History is 

maintained in the Approval pop-up Window
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CRIS to C3D Lab Data Flow

CRIS CDW C3D

Lab Mapping
----------------
WBC Count WBC_SERUM
Basophils BASO
Hemoglobin HEMOGLOBIN
WBC Morphology  ???
---

LLI
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What is LLI?

 LLI is a utility to review and identify specific 
Lab Test Results to be downloaded from the 
CRIS/CDW into C3D

 URL: 
https://octrials.nci.nih.gov/opa46/labloadinter.htm

 Username & Password are same as C3D

https://octrials.nci.nih.gov/opa46/labloadinter.htm
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LLI Search Screen

Search Criteria

Selected Panels

Action Buttons

Workflow
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LLI Search Criteria

• Searching
– Can search by Study, Patient Number, Lab Panel, OC Lab Question, 

Date and/or Time
• Each search field contains Pick List.
• Date and Time allows the ‘%’ wild card
• Date and Time provide the additional option of:

• “On or Before”, “On or After” and “LIKE” comparisons
• Partial dates can be entered as %NOV%
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LLI Search Screen Results

• Search Results
– The result set lists Lab Panels that have at least one lab test available 

for loading that meet the criteria entered into the search fields.
– The sort order can be changed using the column headings.
– Results can be selected/deselected for processing by using the 

individual select check box or Select Buttons. 
– Entire panels of lab tests can then be moved to the Load Cart or 

Marked for Archive.
– Clicking  “View All…” button or by double clicking the record presents 

the Work Cart with specific Lab Test Results for that panel.
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LLI Work Cart

• Work Cart
– Shows Entire Panel, including previously loaded and missing Lab Tests
– The list can be filtered using the “Load Flag” radio buttons.
– Sort by Lab Test Panel Order (R), Test Name, Results, etc.
– Results can be selected/deselected for processing by using the 

individual select check box or Select Buttons. 
– Once selected, the lab tests can be moved to the Load Cart or Archived
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